
  

Newsletter – February 2020    

 

GPR-SLICE Subscribers,     

We would like to welcome the following organizations to the GPR-SLICE 

community: & T Constructions, India 

• University of Archaeology and Anthropology 

• EPRI, Charlotte, North Carolina 

• EnviroSytems Management Inc., Flagstaff, Arizona 

• Zimer Muhendislik, Turkey 

• Called 2 Rescue, Rossville, Tennessee 

• The Cyprus Institute, Nicosia, Cyprus 

• Quality Services Inc., Rapid City, South Dakota 

• Groupe Developpment de Mesures Physiques, EDF, France 

• Natural Sciences and Psychology, Liverpool John Moores University, UK 

• DMT-Group, Canada 

• Geomatics, University of Applied Sciences and Art Northwestern Switzerland 

• United States Army Corps of Engineers, Ft Hood, Texas 

• Geo-Engineering and Testing, Inc., Guam 

• G Map LLC, Oman 

• GEOCND, Italy 

• Geopartner, Denmark 

• Surface Search Inc, Alberta, Canada 



• School of Engineering, Roger Williams University, Rhode Island 

• Atkinson-Noland Associates, Consulting Engineers, New York 

• Terratec AS, Norway 

• Vanasee Hangen Brustlin Inc, Georgia 

• Olson Engineering Inc, Colorado 

• Archaeology, University of Turku, Finland 

• Digital Real Estate Asset Management, Ft Lauderdale, Florida 

• Dept of Mechanical and Construction Engineering, Northumbria University, 
Newcastle, UK 

• Dept of Geosciences, University of Alaska, Fairbanks 

• Reynolds International Ltd, UK 

• Orbital Engineering Inc, Pittsburg, PA 

• Geophysique Sigma, St-Bruno, Canada 

• School of Environmental & Earth Sciences, Univ of Queensland, Australia 

• IAL Inversiones Mineras SpA, Santiago, Chile 

 

Reynolds International Ltd, UK, Liverpool John Moores University UK, and Roger 

Williams University Rhode Island expanded their 3 subscription licenses to include 

GPRSIM.  Terratec, Olson Engineerning, Groupe Developpment de Mesures 

Phsiques France, and the US Army Corps of Engineers in Ft Hood Texas acquired 

multichannel licenses.  Echo GPR in Kansas expanded their GPR-SLICE license to 

include the Bridgedeck module. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

We are happy to announce a partnership with Proceq of Switzerland:  

Here is a press release from August 29, 2019. 

 

Proceq partners with GPR-SLICE to create new cloud-

based, mobile software solutions 

Press Release (Zurich / Los Angeles, August 29, 2019, 10:00 am UTC/GMT -7:00) 

Swiss-based Proceq SA, the global leader in asset inspection solutions, has secured the 

exclusive rights to develop a cloud-based, mobile solution with Geophysical Archaeometry 

Laboratory, developers of the highly regarded ground penetrating radar imaging desktop 

software, GPR-SLICE. 

GPR-SLICE, developed in 1994 by geophysicist Dean Goodman of the Geophysical 

Archaeometry Laboratory in California, was designed to create 2D/3D subsurface images, 

including time slices and 3D volume displays, and is the industry leader for expert users. It 

features overlay options and filters, which provide comprehensive subsurface maps that 

synthesize structures located at different depths. The first Windows version of the software 

was released in 2001 and has since become the gold standard for GPR image post-

processing. 

Proceq’s Screening Eagle inspection technology platform, a mobile app- and cloud-based 

ecosystem, provides cutting-edge client solutions from sophisticated real-time imaging and 

measurement analytics to automated reporting and advanced visualization tools via mobile and 

augmented reality. In Proceq, Dr. Goodman has found an innovative and forward-looking 

partner to develop a next-generation, cloud-based solution. 

Proceq also becomes an authorized distribution partner for the GPR-SLICE PC software, 

which is used today by radar experts worldwide to import and process Proceq GPR data. 

This close partnership continues a push by Screening Eagle Technologies to invest 

substantially – internally and externally – in software to empower infrastructure asset 

inspectors. 



Dr. Goodman said: “Proceq and Tectus Dreamlab have built cutting-edge products for the NDT and 

GPR sectors and I see them as an innovative partner to develop new cloud and mobile solutions based 

on GPR-SLICE. I will continue to support GPR-SLICE PC software and our customers, but look forward 

to our collaboration with Proceq to expand the market for our software and explore future 

technologies” 

Dr. Ralph Mennicke, CEO of Proceq SA, commented: “Adding GPR-SLICE to our processing 

capabilities fits well into our strategy of organic and acquisitive growth to ensure we have 

technologies that empower our customers to make faster and more accurate decisions on their assets. 

GPR-SLICE is a highly-regarded software suite that will give our GPR customers access to more choice 

in comprehensive subsurface imagery.” 

Marcel Poser, Proceq Executive Chairman and Screening Eagle Technologies CEO said: “At 

Screening Eagle Technologies, we are strategically investing into our vision of the future of asset 

inspection. A future that relies on powerful sensors and intelligent software solutions. GPR-SLICE is 

another strong strategic partnership and investment into that future.” 
https://www.proceq.com/company/news-events/show/proceq-partners-with-

gpr-slice-to-create-new-cloud-based-mobile-software-

solutions/?fbclid=IwAR19iWAZI34v9TGqeTc2SiXdQUgLnnBHg03h2VOgdEcccxEe

tqj3tZfj2TM 

 

 

There are no changes to the GPR-SLICE desktop version and we are still 

independently developing the GPR-SLICE Software desktop version that all our 

subscribers currently use.  This new opportunity will provide a cloud-based 

solutions using GPR-SLICE sources to advance real time infrastructure evaluation 

that is being lead worldwide by Proceq.   When the cloud-based solution is 

released this can provide new markets for our current user base to include in 

their portfolio of services and they will be able to acquire this version directly 

from Proceq. 

 

 

 

 

 

 

 

 

 

https://www.proceq.com/company/news-events/show/proceq-partners-with-gpr-slice-to-create-new-cloud-based-mobile-software-solutions/?fbclid=IwAR19iWAZI34v9TGqeTc2SiXdQUgLnnBHg03h2VOgdEcccxEetqj3tZfj2TM
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https://www.proceq.com/company/news-events/show/proceq-partners-with-gpr-slice-to-create-new-cloud-based-mobile-software-solutions/?fbclid=IwAR19iWAZI34v9TGqeTc2SiXdQUgLnnBHg03h2VOgdEcccxEetqj3tZfj2TM
https://www.proceq.com/company/news-events/show/proceq-partners-with-gpr-slice-to-create-new-cloud-based-mobile-software-solutions/?fbclid=IwAR19iWAZI34v9TGqeTc2SiXdQUgLnnBHg03h2VOgdEcccxEetqj3tZfj2TM


Major features and options added to GPR-SLICE include:    

 

• Radar Scan Gain Normalization Filter 

• Overlay of horizon profiles in OpenGL for GPS radargrams 

• Pundit PD8000 - UltraSonic Pulse Echo data integration along with 

new stitching options for GPR or sonic data 

• Support for UTEX Microwave Inspection Systems 

• Import of external layer into OpenGL 

 

 

 

GPR-SLICE new option - Radar Scan Gain Normalization Filter 

     A new option was added to the Filter menu to normalize the gain of the radar 

locations that are affected by antenna coupling (Figure 1). The application of the 
normalization process requires one to first use the Horizon Detection and Mapping 

menu to discover horizon 1. When horizon 1 is detected, in addition to the horizon 
location files written, the amplitude of the horizon is also recorded. These *.amp1 

files for each radargram in the project are recorded in the \topo\ folder and are used 
to normalize the radar pulse gains. The user will have a lot of flexibility to discover 

the best horizon which represents the changes in overall amplitude. Usually choosing 
some portion of the ground wave signal on either peak plus or minus pulses will 

serve best to represent the amplitude changes. The normalization process added to 
the Filter menu will read the horizon 1 across all the radargrams and normalize scans 

based on the gain function 1/((amp-ampmin)/(ampmax-ampmin)). A simulated 
example is shown in the figure where the overall scans are diminished in one area 

and are re-normalized using the new filter. 

     The motivation for this filter came from discussions with Dr. Gianluca Catanzariti 

at (www.3DGeoimaging.com). Gianluca has data at infrastructures sites and they 
found that when the radar system was slightly elevated off the ground due to 

obstructions, that at these locations the ground wave and overall amplitudes were 
reduced. He wanted a method to compensate for amplitude problems caused by the 

antenna coupling with the ground. For their infrastructure sites it is important to 
look at relative amplitudes to predict corrosion - and correcting first for amplitude 

changes caused by antenna elevation/coupling effects is paramount. This new 
normalization option may be the first step in assisting at sites where antenna couple 

problem exists and has created variable amplitudes of transmitted radar waves 

through the ground surface. 

http://www.3dgeoimaging.com/?fbclid=IwAR0ay1lZhee5_2BiftOAJz8sK9p-ns-gXBfPnqWE1d5BWEerDlNomYXHQWM


 

 

Figure 1. New gain normalization filter based on detected horizon 1. 



GPR-SLICE new option - Overlay of horizon profiles in OpenGL for GPS 

radargrams 

 

A request was made by Professor Allen Gontz at the Geology and Geophysics Dept 

at San Diego State University, in addition to being able to show horizon surfaces, to 
also just show simple horizon profiles on top of GPS radargrams in OpenGL. This 

new option was recently added. To launch, the overlay horizons must first have been 
detected and the checkbox switch – overlay horizons – turned on in the Options 

menu. 
 

 
Figure 2. Horizon profiles shown on GPS radargrams in OpenGL. 

 

 

GPR-SLICE new options - Pundit PD8000 - UltraSonic Pulse Echo data 
integration along with new stitching options for GPR or sonic data 
 

 

     At the request of Guido Tronca of GT Studio in Italy we included options to read 
Ultrasonic Pulse Echo (UPE) sonogram data collected with a Proceq Pundit PD8000 

equipment (Figure 3). This equipment has 8 channels and 3 in-line sensors per 

channel for collecting data on infrastructure sites, and in particular for concrete 
imaging. Using the native output format of processed sonograms from this 

equipment in *.csv format, automatic profile import and direct writing into the 
\radar\ folder are available through the Create New Info menu listbox item. 

https://www.facebook.com/photo.php?fbid=10157535750512969&set=gm.2703563546367407&type=3&eid=ARAf8RGRyKy3dJxuZJmWXH23uRt31egbmbktxeINbWfl_chRRyoqEjsroTO4oa8E6SF0C7ZbecYCskKo&ifg=1
https://www.facebook.com/photo.php?fbid=10157535750512969&set=gm.2703563546367407&type=3&eid=ARAf8RGRyKy3dJxuZJmWXH23uRt31egbmbktxeINbWfl_chRRyoqEjsroTO4oa8E6SF0C7ZbecYCskKo&ifg=1


 
     The PD8000 can be collected in the profile mode as well as in a 3D mode. Both 

formats are automatically read in. For data collected in a profile mode, there is 
significant overlap between adjacent sonograms (Figure 4). To stitch these 

overlapping sonograms together a new function called Stitch+Avg was added to the 
Radar Edit menu (Figure 4). In this operation, the number of overlapping scans are 

monitored between adjacent sonograms which can be more than 2 or 3 at a single 
location, and the data are re-weighted on writing the stitched sonogram. Using some 

boxcar filtering can help to smooth out the stitched data (screen shot 3).  The 
stitching option can be used for radar data as well. If there is no overlapping data 

the button simple called Stitch can be used to locate radargrams on the same long 
that one wants to place in a single profile. Null data will also be shown in a stitched 

radargrams that does not have complete areal coverage. 
 

     Ultrasonic equipment can perform better than GPR on some concrete structures. 

UPE usually provides surveyors more reliable imaging of small-scale voids and 
fractures and is superior to GPR in many of these applications.  

 

Figure 3. New option to read in Proceq-Pundit 8000 ultrasonic pulse echo data. 
 

https://www.facebook.com/photo.php?fbid=10157609761002969&set=pcb.2760238037366624&type=3&ifg=1&__tn__=HH-R&eid=ARBfBw9PZqbBAIz-dEsNgeizx__EdcAUzF9vpzyhoAlElBSF8jZjnj0PZhIYx4452OW17M7b3zfmYjZy
https://www.facebook.com/photo.php?fbid=10157609761002969&set=pcb.2760238037366624&type=3&ifg=1&__tn__=HH-R&eid=ARBfBw9PZqbBAIz-dEsNgeizx__EdcAUzF9vpzyhoAlElBSF8jZjnj0PZhIYx4452OW17M7b3zfmYjZy
https://www.facebook.com/photo.php?fbid=10157609761002969&set=pcb.2760238037366624&type=3&ifg=1&__tn__=HH-R&eid=ARBfBw9PZqbBAIz-dEsNgeizx__EdcAUzF9vpzyhoAlElBSF8jZjnj0PZhIYx4452OW17M7b3zfmYjZy
https://www.facebook.com/photo.php?fbid=10157609761002969&set=pcb.2760238037366624&type=3&ifg=1&__tn__=HH-R&eid=ARBfBw9PZqbBAIz-dEsNgeizx__EdcAUzF9vpzyhoAlElBSF8jZjnj0PZhIYx4452OW17M7b3zfmYjZy
https://www.facebook.com/photo.php?fbid=10157609761202969&set=pcb.2760238037366624&type=3&ifg=1&__tn__=HH-R&eid=ARD4cWtwJx3cvXNO4J2zmInWVkxyi-Xcoh0zdYpYOqPt8UL8eRRXQcIAZvCeUs5wO1uFFt0UDkyRgCMC
https://www.facebook.com/photo.php?fbid=10157609761002969&set=pcb.2760238037366624&type=3&ifg=1&__tn__=HH-R&eid=ARBfBw9PZqbBAIz-dEsNgeizx__EdcAUzF9vpzyhoAlElBSF8jZjnj0PZhIYx4452OW17M7b3zfmYjZy


 

 

Figure 4.  New stitching option to weight overlap sonograms or radargrams into 

a single profile 

 

https://www.facebook.com/photo.php?fbid=10157609761202969&set=pcb.2760238037366624&type=3&ifg=1&__tn__=HH-R&eid=ARD4cWtwJx3cvXNO4J2zmInWVkxyi-Xcoh0zdYpYOqPt8UL8eRRXQcIAZvCeUs5wO1uFFt0UDkyRgCMC
https://www.facebook.com/photo.php?fbid=10157609761202969&set=pcb.2760238037366624&type=3&ifg=1&__tn__=HH-R&eid=ARD4cWtwJx3cvXNO4J2zmInWVkxyi-Xcoh0zdYpYOqPt8UL8eRRXQcIAZvCeUs5wO1uFFt0UDkyRgCMC
https://www.facebook.com/photo.php?fbid=10157609761202969&set=pcb.2760238037366624&type=3&ifg=1&__tn__=HH-R&eid=ARD4cWtwJx3cvXNO4J2zmInWVkxyi-Xcoh0zdYpYOqPt8UL8eRRXQcIAZvCeUs5wO1uFFt0UDkyRgCMC


GPR-SLICE provides support for UTEX Microwave Inspection Systems 

     Most GPR equipment works in the range from 10MHz-2.5GHz, and very few of 
us were aware in the GPR world that a lot of microwave inspections for NDT is done 

from 3-16GHz!  New systems are also coming into the market shortly with 
frequencies up to 45 GHz!   We were asked by the Electric Power Research Institute 

- EPRI a non-profit that engages with industry and makes recommendations - if we 
could integrate microwave 3D data into GPR-SLICE and allow many more data 

filtering and display options that we do in GPR world that are currently not being 
done with microwave inspection platforms. The UTEX format with *.stl format in 

Equipment setting in the New Project menu is actually continuous wave format with 
an ASCII data volume of comprised of real and imaginary components of the power 

spectra.   GPR-SLICE on import of these data will convert to pulse format using 

inverse Fast Fourier Transforms. 

     An example dataset from one of our first test requests with EPRI is shown (Figure 

5). The opportunities for GPR surveys companies to move into acquiring data from 

inspection systems or to acquire these inspections systems as another service are 
endless. NDT goes into the materials world and testing of equipment manufacturing 

using high frequency microwaves is a larger market than the GPR world and involves 

quality control manufacturing and a host of other testing requirements. 

 

Figure 5. Example of UTEX microwave data imported to the OpenGL XYZ-2D menu. 



GPR-SLICE new option - Import of external layer data into OpenGL 
 

     An option was added to the Import 2D Geophysical Data which allows gridding 
of any dataset into GPR-SLICE (Figure 6). If the output file name has "Layer" in it 

on import, this data will be recognized as a flag to add into the Horizon listbox in 
OpenGL. The new option also has additions of several menu slots to adjust the 

import data either for scale or to change depth data imported into elevation data. 
Other recent additions in the Import 2D Geophysical Data menu are the option to 

translate imported data with a logarithm such as was recently needed for a recorded 

resistivity dataset. 

 

 

Figure 6.  Example of importing an external layer dataset into OpenGL. 



Software Update - Release of GPR-SLICE v7.MT (reposted and updated 

from a August Newsletter) 

     If you have not been following the updates on the website or our FB group 

page then the biggest news since OpenGL was added to the software some 10 

years ago is that GPR-SLICE v7.0 is now GPR-SLICE v7.MT!   So, what’s new?  

Well the MT of course!   GPR-SLICE is now a MultiThreaded – MT - application!  

If you have multiple cores on your computer, you can speed up processing by 

almost N times – where N is the number of logical cores!   On many computers 

one can send 2 threads per core for processing - where the number of logical 

cores can be 2 times the number of actual cores.    When one processes a set of 

radargrams, GPR-SLICE will send out each radargram process as a separate 

thread to be executed in Windows and to be run simultaneously on as many cores 

as exist on a computer.      All-in-all, the speed of processing a set of radargrams 

can be increased almost by the number of logical cores one has on their 

computer!      

 

 

Figure 7.  Option menu showing available and updated multithread processes.   



     The list of processes currently available are outlined in the Options menu 

(Figure 7) and include radargram filtering, radargram conversion, radargram 

editing, time slice binning and gridding operations.   Specifically:  

  

• Convert 16 bit radargrams    

• Convert 32 bit radargrams  

• Bandpass filtering  

• Background filtering   

• Diffraction stack migration  

• Kirchhoff Migration  

• Hilbert Transform  

• Spectral Whitening  

• Boxcar Smoothing  

• Regain 16 bit radargrams (newly added MT operations) 

• Regain 32 bit radargrams 

• Spectral whitening 

• Cepstrum deconvolution 

• -----  

• Inverse distance gridding  

• Kriging gridding  

• -----  

• Slice binning  

• -----  

• Time 0 detection  

• Time 0 correction   

  

     These operations are the most fundamental processes and have been 

included in the recent MT release.   The desired number of cores can also be set 

and is available in the Options menu.  If you are running other applications, you 

can limit GPR-SLICE to any portion of the available logical cores so all active 

applications will run smoothly.   In addition, there can be a limit to the speed of 

operations such as when disk writing, so the user may want to test how many 

cores assigned improves the final speed of operations.   This can also be different 

with some of the processes that require different kinds of computer resources.  

     Note: With MT turned on all processing graphics are disabled.  For quick 

viewing of radargrams signal processing, radar editing or gridding operations, 

the same checkbox that is available in the Options menu is conveniently available 

in these menus as well to shut MT off.  

 



Additional options added to GPR-SLICE Software 

 

• British National Grid conversion from WGS84 lat./long added to Create New Info menu 
and GPS Track menu 

• TSPoints anomaly labeled with point # 
• Profile name included in Bridgedeck module detection dialog 
• Font size export for dxf reduced by 50% for better showing of drawn objects in OpenGL 
• Import of Proceq Infoxy.dat in the Create New Info menu updated for new USC-2 LE 

BOM format from UTF-8 
• Current coordinate system in the GPS track identified in labeling above the option to 

convert to a different coordinate system 
• UTC time or decimal seconds time queried during GPS latency corrections 
• Radargram stitching with overlap averaging added to the Radar Edit menu 
• Pundit PD8000 3D sonic data import added to Create New Info menu 
• Reverse info button to generate a saved reverse info file for use in staggering 

corrections 
• Bridgedeck module detection dialog now programmed for hyperbola inserting and 

adjustments for GPS radargrams 
• Proceq variable grid auto infoxy creation added to Create New Info menu 
• OpenGL display of horizon profile overlays added for GPS radargrams 
• Normalization of radargram gain based on horizon 1 amplitude profile detected in the 

Horizon menu 
• UTEX Microwave inspection *.sdt binary format and *.txt pulse data format integrated 
• Radar color palette set now shows in conversion, regain and migration menus and does 

not default to grayscale 
• Cepstrum deconvolution multithread processing added to the Filter menu 
• MIN (grid1+a*grid2) option added to Grid menu to assist in road surveys and to help 

estimate ground cover minimum areas 
• UTEX Inspection ware 3D format for 3-14GHz microwave equipment added  
• Batch append of gridsets that have adjusted transforms for correcting mosaic noises 

added to the Pixel Map menu 
• Impulse Radar Crossover dual frequency 32 bit radargram conversion format added 
• Sample Start/End values added to Boxcar Filter - useful for smoothing out and limiting 

smoothing to just the ground wave reflection 
• Proceq SEGY Get XY button added to Edit Info File menu to read survey wheel lengths 

for individual .csv files 
• Composite time slice menu enhanced to allow overlapping grids (with null areas) to be 

combined together and advanced detection of clicked on grid  
 

Upcoming Events  

  

GPR 2020 Golden Colorado, June 14-18, GPR-SLICE Software Exhibit – booth 

#6 

 
*This newsletter is available in *.pdf form at https://gpr-survey.com/newsletters.html  


